Contents

Introduction ................................................................................................................. 4

About this Guide........................................................................................................ 4

Other Resources ......................................................................................................... 5

What is Edgecam? ........................................................................................................ 6

Supporting Applications.............................................................................................. 7

Installing Edgecam ..................................................................................................... 8

Installing Edgecam ..................................................................................................... 8

If the Edgecam DVD does not Autorun ...................................................................... 8

What else can I Install? .............................................................................................. 9

Licensing your Edgecam Installation .......................................................................... 9

Preparing Edgecam .................................................................................................... 10

Switching to Homework Mode .................................................................................. 10

Starting Edgecam ....................................................................................................... 11

Registering Edgecam ................................................................................................. 11

The Edgecam User Interface ...................................................................................... 12

Customising the User Interface .................................................................................. 13

Checking the Defaults File ........................................................................................ 14

The Milling Exercise ................................................................................................... 15

Loading the CAD Model ............................................................................................ 16

Switching to Isometric View ...................................................................................... 17

Zooming In and Out .................................................................................................. 17

Creating the Stock ...................................................................................................... 18

Using Undo ................................................................................................................ 19

Showing Translucent Stock ....................................................................................... 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>20</td>
</tr>
<tr>
<td>Finding the Features</td>
<td>22</td>
</tr>
<tr>
<td>Viewing Features in the Feature Browser</td>
<td>23</td>
</tr>
<tr>
<td>Saving and Opening your Work</td>
<td>24</td>
</tr>
<tr>
<td>Specifying the ToolStore Database</td>
<td>25</td>
</tr>
<tr>
<td>Specifying the Material</td>
<td>26</td>
</tr>
<tr>
<td>Creating the Machining Sequence</td>
<td>27</td>
</tr>
<tr>
<td>Drilling the Hole</td>
<td>28</td>
</tr>
<tr>
<td>Roughing the Part</td>
<td>30</td>
</tr>
<tr>
<td>Rest Roughing the Part</td>
<td>31</td>
</tr>
<tr>
<td>Machining the Flat Lands</td>
<td>32</td>
</tr>
<tr>
<td>Profiling the Inner Profile (Central Boss)</td>
<td>34</td>
</tr>
<tr>
<td>Profiling the Outer Profile</td>
<td>35</td>
</tr>
<tr>
<td>Profiling the Pockets</td>
<td>36</td>
</tr>
<tr>
<td>Simulating the Machining</td>
<td>38</td>
</tr>
<tr>
<td>Generating CNC Code</td>
<td>40</td>
</tr>
<tr>
<td>Creating a Code Generator Exercise</td>
<td>40</td>
</tr>
<tr>
<td>Starting the Code Wizard</td>
<td>40</td>
</tr>
<tr>
<td>Opening the Template</td>
<td>40</td>
</tr>
<tr>
<td>Working through the Screens</td>
<td>42</td>
</tr>
<tr>
<td>Reviewing the Settings</td>
<td>42</td>
</tr>
<tr>
<td>Saving the Configuration</td>
<td>43</td>
</tr>
<tr>
<td>Compiling</td>
<td>43</td>
</tr>
<tr>
<td>Using the Code Generator</td>
<td>43</td>
</tr>
</tbody>
</table>
Introduction

About this Guide

In this guide you work through a series of exercises that teach you some of the basics of using Edgecam and Edgecam Solid Machinist. You become familiar with the user interface and some of the Edgecam concepts.

The guide starts with overview information and a basic installation procedure. This is followed by some preparation of Edgecam for the exercises.

You then work through the complete process of producing toolpaths for machining a part supplied as a solid model.

Please note that:

- In the exercises you use the intelligence of Edgecam to quickly produce results. You see how Edgecam speeds up your work by automatically setting many of the machining details for you. As your knowledge of Edgecam increases you will learn how you can take more detailed control of your machining, if necessary.

- As a general introduction to the Edgecam software the guide is not a substitute for a formal instructor-led training course.

- The guide assumes that you are familiar with a PC and Microsoft Windows. Some experience with CAD/CAM methods and terminology would be beneficial, but is not essential.

- The guide is for use with Edgecam version 2014 R1 and above.
Other Resources

Other resources to help you in your Edgecam work are:

**Graphical help on your settings in dialogs**

![Graphical help](image)

**Online help accessible directly from dialogs**

![Online help](image)

**Edgecam Help menu**

- Details of new features in the release.
- Some exercises that teach you important aspects of Edgecam design and manufacture.
- Useful Web-based support resources
What is Edgecam?

Edgecam is a computer aided manufacturing (CAM) system that allows you to generate machining strategies and CNC code from CAD models.

Here are the main stages in using Edgecam:

**CAD**
- Load the part
- Import solid models or drawings from Part Modeler or other major CAD systems

**CAM**
- Create the machining sequence
- Use Edgecam Manufacture Mode

**SIMULATE**
- Simulate machining
- Use Edgecam Simulator

**GENERATE**
- Generate CNC code
- Use the Edgecam Generate Code command
Supporting Applications

To support the core Edgecam activities there are a number of tools and utilities. You can access these from the Edgecam program group (Start menu ▶ All Programs ▶ Edgecam):

- **Code Wizard** - Configure the requirements of a CNC machine into a new code generator, which is then used to produce CNC code tailored to that machine. (Not available in Homework Mode.)
- **Comms Setup** - Set up communication links so that you can transmit and receive files between PCs and machine tools over your local area network. (Not available in Homework Mode.)
- **Editor** - A dedicated CNC file editor with essential editing, comparison and formatting features.
- **Job Manager** - Manage 'jobs' (kits of tooling).
- **Technology Assistant** - Automatically calculate feeds and speeds for tools to be used within Edgecam.
- **Toolkit Assistant** - Manage your ToolStore database more effectively and streamline the process of preparing to write an NC file.
- **ToolStore** - Store, manage and retrieve details of your tools.
- **ToolStore Administrator** - Manage your tooling databases - switch active database, backup, restore, delete and so on.
- **Utilities** - A range of utilities for managing the Edgecam environment. There is a utility for setting the paths for various categories of Edgecam related files for example, or for restoring factory settings.
Installing Edgecam

Installing Edgecam

On inserting the DVD the Edgecam Installation screen appears.

Click Install Edgecam and follow the on-screen instructions.

For a quick and easy installation that is ready for the exercises, at the prompts accept all the default choices. At the ‘Type of Installation’ prompt choose Typical.

If the Edgecam DVD does not Autorun

The installer should start automatically when you insert the Edgecam DVD.

If the installation menu is not displayed automatically:

1. Open Explorer and go to the Edgecam installation DVD.
2. Double-click starthere.hta to display the menu.
What else can I Install?

You have already installed the necessary software for the exercises.

For your information, here are some other software options:

<table>
<thead>
<tr>
<th>Install</th>
<th>If</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edgecam CAD Links</td>
<td>You want to be able to launch Edgecam from your CAD system. You can install links in:</td>
</tr>
<tr>
<td></td>
<td>• Autodesk Inventor</td>
</tr>
<tr>
<td></td>
<td>• SolidWorks</td>
</tr>
<tr>
<td></td>
<td>• Solid Edge</td>
</tr>
<tr>
<td></td>
<td>Note that Part Modeler automatically includes a link to Edgecam.</td>
</tr>
<tr>
<td>Part Modeler</td>
<td>You want to use Part Modeler, a powerful solids-based CAD package.</td>
</tr>
</tbody>
</table>

Licensing your Edgecam Installation

To run Edgecam (industrial or educational version), you need to licence your software. There are two types of Edgecam licence, standalone or multiple user network licences.

For further information, please refer to the Licensing Guide. To access the Licensing Guide, click Start button ► All Programs ► Edgecam 2014 R1 ► Help ► Licensing Guide.
Preparing Edgecam

Switching to Homework Mode

So that you can complete the exercises no matter what Edgecam licence you have, you use Edgecam in Homework Mode.

**Note:** If you are using an educational classroom or Homework license, you do not need to check the Homework Mode option.

**To switch from licensed to Homework Mode**

1. Exit Edgecam if it is open.
2. Find the Windows Notification Area (usually at the bottom right of the screen, where the time is displayed).
3. In this area right-click the CLS icon and on the shortcut menu click **Homework Mode** to enable it.

The next time Edgecam starts it will be in Homework Mode.

**Switching back to Fully Licensed Mode**

You might need to change back to fully licensed mode in between exercise sessions. To do this, close Edgecam (you can use the Close button in the top right corner of the Edgecam window - see page 23) and repeat the step above - clicking 'Homework Mode' again disables it, and Edgecam will next start in the normal licensed mode.
Starting Edgecam

In a standard installation:

- Click the Edgecam icon on your desktop.
- Alternatively on the Windows taskbar, click the Start button, then All Programs ► Edgecam 2014 R1 ► Edgecam.
- You see a message dialog stating you are in Homework Mode. Click Yes to continue.

Registering Edgecam

If you are starting Edgecam for the first time you now have an opportunity to register.

We strongly recommend you register your copy of Edgecam. This allows you to access online support and Frequently Asked Questions, track the progress of service calls and download the latest Edgecam updates.

After completing the registration Edgecam starts ready for you to begin work on a new part.
The Edgecam User Interface

Your Edgecam window should be configured for the exercises, and look like this:

To ensure you are using the correct configuration (in case there have been changes to the configuration since installation):

- Right-click on a toolbar and in the menu that appears rest the cursor on **Profiles** ►, then in the menu that opens rest the cursor on **Mill Profile** ►, then click **default.config**.
Customising the User Interface

You can customise the user interface to suit your working preferences. When first starting with Edgecam for example, you might want to display the text of buttons as a reminder of what they do:

1. Right-click on any toolbar and in the menu that appears, click **Customise**.

2. In the Customise dialog, click the **Toolbars** tab, scroll down the list to the **Standard** toolbar and click to select it.

3. Now click **Show text labels** to check it. Notice how the buttons in the Standard toolbar now have labels.

4. Leave Show text labels checked or unchecked as you prefer and close the dialog.
Checking the Defaults File

The default installation of Edgecam is suitable for the exercises in this booklet.

To be sure you are using the correct defaults file (in case there have been changes to the defaults since installation):

1. On the Options menu, click Select Defaults to open the Defaults dialog.

2. From the Name drop-down list, select mill_mm.dft (if not already selected).

   This enables the milling (XY) environment and millimetre (mm) units. (The defaults file also contains many other settings, such as the Tolerance setting.)

3. If you had to change to mill_mm.dft, and you want Edgecam to automatically use this file every time it starts, set the New Part Defaults option to Selected File.

   (Note that you do not need to reset the defaults every time you reopen saved work as the settings become part of the saved file.)

4. Click OK.
The Milling Exercise

In the exercise you learn how to:

- Open a solid model.
- Change the view - select Isometric and zoom in and out.
- Create stock.
- Specify the stock material.
- Undo after a mistake.
- Find ‘features’ in the solid model, on which to base your machining.
- Save your work.
- Specify a ToolStore database.
- Create machining for the features using ‘operations’. An operation is a complete package, including machining cycles (that control the toolpath) and any necessary moves to tool change, tool changes and so on.
- Simulate your machining.
- Generate CNC code for the machining.
**Loading the CAD Model**

1. On the **Standard** toolbar (or **File** menu), click **Open**.

2. In the Open dialog, navigate to the folder:

   \*installation folder\*\Cam\Examples\Tutorial\Solid Machinist\Parasolid

   For example:

   C:\Program Files\Planit\Edgecam 2014 R1\Cam\Examples\Tutorial\Solid Machinist\Parasolid

3. From this folder open **prismatic milling.x_t**.

   The part opens looking like this:
Switching to Isometric View

You can change the view to 'Isometric' for a more three dimensional impression of your part:

- Right-click on the View Caption (in the bottom left corner of the graphics area) and on the shortcut menu click Isometric.

You part now looks like this:

Zooming In and Out

You can enlarge or reduce the size of the part on the screen:

- Roll the top of the mouse wheel away from you to zoom in.
- Roll the top of the mouse wheel towards you to zoom out.
Creating the Stock

Stock represents the billet of material from which the part is to be machined. (When you come to use Edgecam Simulator this material is shown being machined away to produce the part.) To create the stock:

1. On the Geometry menu, click Stock/Fixture.
2. In the dialog that opens make these settings. Be sure to click Automatic Stock first.
3. Click OK to add the stock.

An outline appears showing your added stock.
Using Undo

If you make a mistake you can cancel your last action:


Your added stock disappears. You could now recreate stock with different settings, for example.

Our stock is OK however, so to 'undo the undo':


Your stock reappears.

Showing Translucent Stock

1. On the Display toolbar (to the right of the Standard toolbar), click Toggle Stock.

   The stock display changes to 'translucent'.

   ![Translucent Stock]

2. Click the button again to switch back (to 'wireframe').

Leave the stock displayed as you prefer (stock is shown as wireframe in the exercises).
Finding the Features

Features are specific shapes of the model that you can identify in Edgecam and base your machining on. To find features:

1. On the **Standard** toolbar, the **CPL Selector** needs to be set to **Top**. If it is not, click on the selector and in the list that opens click **Top**.

2. On the **Solids** menu, click **Feature Finder**.
3. In the Feature Finder dialog leave the General tab settings at their defaults. (Ensure that Select Face(s) is not checked. With no CPL set it will default to Top.) In the Mill tab, set the options as shown here. Then click OK.

4. Note how features are displayed in a 'tree' view in the Features window:
Viewing Features in the Feature Browser

The Features window is a central area for working with the loaded solids, and any features found in the solids.

By default, features are shown in a ‘Tree’ view.

For an alternative display, click the List View button in the title bar of the Features window.

In ‘List’ view, features are presented in a table, with one row per feature and columns for some of the feature properties. Features are grouped together by feature type.

To continue with the tutorial, switch back to the tree view. Note how the features are now also displayed in the new order in this view.
Saving and Opening your Work

It is a good idea to save your work regularly so you do not accidentally lose it:

1. On the **Standard** toolbar (or **File** menu), click **Save**.

2. As this is the first save, a dialog opens for specifying a file name and location. Save to a folder and file name of your choice. For the file name you could add your initials to the default name (which is from the original solid model file).

All your work in Edgecam is saved to the '.epf' file, including features and machining instructions (which you will be creating in later exercises).

The '.epf' format is for educational purposes, with restrictions on what you can do with the file (for example you cannot generate CNC code). The normal licensed file format is '.ppf'.

You could now take a break from the exercise and close Edgecam:

1. Click the **Close** button in the top right corner of the Edgecam window. (Alternatively, on the **File** menu click **Exit**.)

To reopen the file and continue with the exercises after restarting Edgecam:

2. Click the **File** menu and select your saved file from the 'recent files' list at the bottom of the menu. (Alternatively, on the **File** menu click **Open**, then navigate to the file and open it.)
Specifying the ToolStore Database

You will be selecting pre-defined tools from ToolStore. Using ToolStore you can access tools from different databases, so you need to ensure you are using the correct example database that is installed with Edgecam.

1. On the Options menu, click Preferences.

2. In the Preferences dialog, click the Tool Libraries tab.

![Preferences dialog showing ToolStore section]

3. The Database entry should be

   \(computer\_name\)\(\text{\textbackslash ecsqlexpress\textbackslash Sample\_ToolStore<version number>}\)

   for example:

   \(frank\_smith\text{\textbackslash ecsqlexpress\textbackslash Sample\_ToolStore\_2014R1}\)

4. If this is not the entry, click Modify to open ToolStore Administrator.

5. In the Active ToolStore Database dialog, click Change active database.

6. In the Change Active ToolStore Database dialog, click Browse... to select a new active database. Select ‘Sample_ToolStore<version number>’ from the list and click Select.

7. Click Change to accept the changes and then \(\text{\textasteriskcentered}\) to close the dialog.

8. Click OK to close the Preferences dialog. The database switch is now complete.
Specifying the Material

As you will be using operations, speeds and feeds are automatically calculated. These are based on the material being machined, so you need to specify this.

1. On the Options menu, click Select Technology.

2. To select the Component Material, click Browse.
   (You leave the default setting for Technology Adjustment unchanged.)

3. In the dialog that opens scroll down the list in the All tab, then click Mild Steel EN8 to select it, then click Select.

4. Click OK to close the dialog.
Creating the Machining Sequence

You now start to create your machining instructions.

1. Click **Switch to Manufacture Mode** in the top right corner of the Edgecam window.

2. The first time you enter Manufacture mode for the part the Machining Sequence dialog opens. This allows you to define a new 'sequence' to store your machining instructions. Set up the dialog like this (set **Discipline** first and for Machine Tool select **training mill mm.mcp**).

   ![](image)

   The 'Machine Tool' setting is the code generator for generating CNC code from the sequence. You specify this now to help ensure you develop machining that is compatible with the machine capabilities.

3. Click **OK** to confirm and close the dialog.

4. If you see prompts for more details, click Cancel to accept the defaults. In Manufacture mode you will find the user interface has changed slightly to support your machining work.
Drilling the Hole

Now you drill the hole through the centre of the part.

1. On the Operations toolbar, click **Hole Operation for Milling**.

   (In a default installation, the Operations toolbar is docked at the top of the graphics screen.)

2. You are prompted to **Select Points**. Move the cursor over the centre of the hole in the boss until the hole changes colour. Now click, and the hole changes colour again to show it is selected.

3. Right-click to terminate the points selection or click the **Finish** button (in the top right corner of the screen).

4. In the Hole Operation dialog, make these settings (see image on the right)

5. Click **OK**.

6. The Hole operation is now created. Click the **Sequence** window tab, then click the ‘+’ symbol for the Hole operation to see the instructions within the operation. (In the graphics area you see a graphic representing the automatically-selected tool. Note how this has been given the diameter of the hole.)
Roughing the Part

Now you rough the part.

1. On the Operations toolbar, click **Roughing Operation**.

2. You are prompted to **Select geometry to machine**.

   Move the cursor over the part until the whole part changes colour and the ToolTip indicates 'Solid'. Click to select the part. Terminate the geometry selection with a right click.

3. You are prompted to **Select boundary entities**... Terminate without selecting anything.

4. The Roughing Operation dialog opens.

   In the **General** tab make these settings. (Note how you see an explanatory graphic when you click an option.)

   Ensure that **Select Stock** is checked.

   Do **not** click OK yet.
5. Go to the **Tooling** tab and click **Find** to open ToolStore. In the tooling list scroll to **14.0 mm Multi-Flute End Mill** and click to select it. Click **Select**. (If at any point during the exercise you cannot see the required tool in the list, click **Use Filters** on the right side of the ToolStore dialog.)

6. Click the **Depth** tab and set **Clearance** to **5**, **Level** to **0**, **Depth** to **0** and **Cut Increment** to **2**. Click **OK** to close the dialog.

7. You are prompted to **Select stock**. Rest the cursor on one of the lines comprising the top profile of the stock. The line changes colour and the ToolTip indicates 'Stock'. Double-click to select the whole top profile. Then right-click to terminate the stock selection.

The Roughing operation is now created. The toolpath is displayed on the part.

8. Click the **Sequence** window tab. Now click the ‘+’ symbol for the Roughing operation to see the instructions within the operation.
Rest Roughing the Part

In the previous roughing operation the tool was too large to remove all the material (the tool could not fit into the pockets, for example). You now 'rest rough' with a smaller tool to remove this material.

To do this, repeat the previous Roughing operation, but with slight changes. Here is a summary, with the changes marked *

2. Select the whole solid.
3. Select no boundaries.
4. In the Roughing dialog, General tab, set Rest Rough to checked *, Offset to 0.2, and Select Stock to unchecked * (you can leave the other settings as they are).
5. Click the Tooling tab and from ToolStore select the tool 6.0 mm Multi-Flute End Mill-LS* (you can leave the other settings as they are).
6. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0 and Cut Increment to 2. Click OK to close the dialog and generate the operation. (There will be no prompt for stock.)
7. In the Sequence window rest the cursor on 3 Roughing Operation (that you have just created). Notice how the toolpath for the operation becomes highlighted.
Machining the Flat Lands

You now use a finishing tool on the flat areas, removing the material left by the 0.2 offset in the previous Roughing operations.


2. You are prompted to Select geometry to machine. Select the whole solid and terminate, as you did before for the Roughing operations.

3. At the Select boundary entities... prompt right-click to terminate without making a selection.

4. The Flatland Operation dialog now opens. In the General tab make these settings. (The Stand Off Distance leaves an un-machined border round the flats to be removed in subsequent Profiling operations.)

5. Click on the Tooling tab and from ToolStore select 8.0 mm Multi-Flute End Mill-LS. (Other settings can be left as they are.)

6. Click the Depth tab and set Clearance to 5, Level to -0.1 and Depth to 0.

7. Click OK to close the dialog and generate the operation.
Profiling the Inner Profile (Central Boss)

Now you profile finish the central boss, this time using a different method.

1. Click the **Features** window tab and in the Features window click on the **lower 2D Boss**.

   With a right mouse click, open the shortcut menu and select the **Profiling Operation**.

2. At the **Select boundary entities...** prompt right-click to terminate without making a selection.

3. The Profiling dialog now opens. In the **General** tab make these settings.

   Do **not** click OK yet.
4. Click the Tooling tab and from ToolStore select the **8.0 mm Multi-Flute End Mill** (other settings can be left as they are). Remember, if you cannot see the tool in the list, click Use Filters on the right side of the ToolStore dialog.

5. Click the **Depth** tab and set **Clearance** to 5, **Level** to 0, **Depth** to 0, **Cut Increment** to 2 and **Cusp Height** to 0.

6. Click **OK** to close the dialog and generate the toolpath.

7. The tool graphic can sometimes get in the way. In the Display toolbar click the ‘▽’ symbol of the **Tool Display** button and click **Hide**. Repeat to show the tool again. Set this as you prefer.

With the tool now hidden you have an unobstructed view of the part and its new toolpath.
**Profiling the Outer Profile**

Now you machine the outer perimeter of the part.

To do this repeat the previous Profiling operation, but with slight changes. Here is a summary, with the changes marked ‘*’:

1. Click the **Features** window tab and in the Features window click on the **top 2D Boss***. As the feature is highlighted in the graphics area you may notice slot markers in the four recess areas. These are not used in this exercise.

2. With a right mouse click, open the shortcut menu and select the **Profiling Operation**.

3. Select no boundaries.

4. In the Profiling dialog **General** tab, set **Offset** to 0 and **Lead Radius** to 4. (Other settings can be left as they are).

5. In the Profiling dialog **Tooling** tab, check the **Use Current Tool** option. (Other settings can be left as they are.)

6. In the Profiling dialog **Depth** tab, set **Clearance** to 5, **Level** to 0, **Depth** to 0, **Cut Increment** to 2, and **Cusp Height** to 0. Click OK to close the dialog and generate the operation.

7. Rest the cursor on the new operation to highlight its toolpath.
Profiling the Pockets

You now machine the pockets.

To do this repeat the previous Profiling operations, but with slight changes. Here is a summary, with the changes marked ‘*’:

1. On the *Operations* toolbar, click *Profiling Operation*.

2. Select all four pocket features*. This time use a different method: Click the *Features* window tab and in the Features window click on the top *2D Pocket*, then hold down the *Shift* key and click on the bottom *2D Pocket*. Move the cursor back into the Graphics area and right-click to terminate the selection.

3. Select no boundaries.

4. In the *Profiling* dialog *General* tab, set *Offset* to *0* and *Lead Radius* to *4*. (Other settings can be left as they are).

5. In the *Tooling* tab, click *Find* to open ToolStore. Select the *3.0 mm Multi-Flute End Mill**. (Other settings can be left as they are.)

6. In the *Depth* tab, set *Clearance* to *5*, *Level* to *0*, *Depth* to *0*, *Cut Increment* to *2*, and *Cusp Height* to *0*. Click *OK* to close the dialog and generate the operation.

7. Rest the cursor on the new operation to highlight its toolpath.
Simulating the Machining

You can now simulate your machining. The simulation gives you a visual 'confidence check' of your machining. You can check, for example, that you have not forgotten to machine a feature, and that there are no collisions.

You will be quickly running through the main features of the Simulator, there are many more you will use with experience.

- In Edgecam, on the Main toolbar click Simulate Machining.

You see the Simulator window containing your un-machined stock:

Use these buttons on the Main toolbar to control the simulation at any time:

- Start/Resume
- Play # Cuts
- Stop
- Rewind (To Start)
- Fast Forward (To End)
Drag the Speed Control slider to the left and right to control the speed of the simulation.

If speed control is not enabled, click the **Speed Control** button to activate the slider.

**To simulate your machining sequence**

On the Main toolbar, click **Start** to begin the simulation.

You see your part being machined out of the stock. Notice how the progress of the simulation is indicated in the Sequence Browser.

Collisions are indicated by red ‘flashes’. To prevent collisions, you would edit the operation parameters and/or select a different tool, for example.
Generating CNC Code

Once machining is completed, you generate the CNC code.

- Back in Edgecam, on the **Main** toolbar click **Generate Code**.

A message tells you 'This option is not available in Homework Mode', so this is as far as you can go with the live exercise.

If you were working on a '.ppf' part in Licensed mode, you would see the Generate CNC Code dialog.

After specifying the CNC Name and clicking OK, the code would be generated. With the Open Editor option checked, the Editor program is opened, showing the just generated code.
Exercise Summary

You have now completed the exercise.

You have taken a solid model design and produced CNC code for producing parts to the design.

You have learnt how to:

- Open solid model parts generated in CAD packages.
- Change view - select Isometric and zoom.
- Create stock representing the raw billet.
- Specify the stock material.
- Find 'Features' in the model: holes, pockets and bosses.
- Save your work.
- Specify a ToolStore database.
- Create machining for the features, using operations.
- Use Simulator to provide a visual confidence check of your machining.
- Generate the CNC code.
Creating a Code Generator Exercise

A code generator interprets your Edgecam machining sequence to produce CNC code that is tailored to a particular target CNC machine. When you create a code generator you configure the characteristics of the target machine into it.

Code generators are stored files; a typical example is the 'facnuc3x.mcp' you used earlier. (There are also '.tcp' turning code generators and '.wcp' wire erosion code generators.) You create and configure code generators using the Code Wizard.

Starting the Code Wizard

You cannot run Code Wizard in Homework Mode, so you now need to switch to the normal licensed mode - see page 10 for details.

Then, in a standard installation:

- Click the Start button, then All Programs ► Edgecam ► Programs ► Code Wizard.

Opening the Template

A template contains a typical CNC machine configuration that you can use as a starting point, to be modified for your particular machine. You choose the template closest to your particular machine.

- After starting the Code Wizard you see this dialog. Click Start a new document and click OK.
• In the next dialog click **Lathe** or **Mill**, depending on your type of work. (For this exercise, your choice is not important.)

• In the next dialog make further settings relating to your machine's configuration.

Click on one of the 'adaptive' templates and click **OK**.

(Again your choices are not important for the exercise.)
Working through the Screens

- You now see this wizard screen. Start to work through the screens to gain some idea of the settings you can make. Use the Next and Back buttons to navigate. You can simply step through the screens without making changes. This screen keeps reappearing to show the completed steps. You can click on a step (such as '3: NC Style....') to jump straight to it 'out of sequence'. At any time you can click Finish to accept the defaults.

Reviewing the Settings

- Once you have completed the wizard you can still make changes. You now work in a 'tree' view of the settings. Click the '+' symbol to open a branch. Double-click on an entry in the tree to open a dialog for changing the settings.
Saving the Configuration

You can save your settings. Once saved you can restore and change them later, in the tree view, without having to work through the wizard again.

1. On the **Standard** toolbar (or on the **File** menu), click **Save**.
2. Use the dialog to save the '.cgd' file with a name, and in a folder, of your choice.

Compiling

- On the **Standard** toolbar (or on the **File** menu), click **Compile**.

  A code generator file is created. This is automatically named after the saved '.cgd' file (or 'Untitled' if there was no save), with the appropriate extension (such as '.mcp' for a milling code generator).

Using the Code Generator

You use the code generator by specifying it as the Machine Tool setting in the Machining Sequence dialog.

You did this in the milling exercise; see page 26.
Index

B
Boundary entities - selecting .......... 28

C
CAD part - loading ...................... 16
Cancelling last action .................. 19
Central boss - profiling ................. 32
Clearance - setting ..................... 27
CNC code
editor ..................................... 38
generating ................................ 38
Code generator
compiling .................................. 43
creating .................................. 40
specifying ................................ 26
Code Wizard
opening template ....................... 40
saving configurations .................. 43
stepping through ....................... 42

D
Defaults file - using correct .......... 14

E
Edgecam
DVD ....................................... 8
installing ................................. 8
registering .............................. 11
starting .................................. 11

F
Feature browser .......................... 22
Feature finding ........................... 20
Flatland operation ....................... 31

H
Hole - drilling ............................ 27
Hole operation - creating ............... 27
Homework mode - switching to ......... 10

I
Inner profile - machining ............... 32
Installing Edgecam ...................... 8
Isometric view - selecting ............. 17

L
Licenced mode - switching to ........... 10
Loading, CAD model .................... 16
Lower boss - profiling ................... 34

M
Machining - simulating .................. 36
Machining sequence - creating ......... 26
Manufacture mode - switching to ...... 26
Material - specifying ................... 25
Milling exercise - introduction ........ 15

O
Opening parts ............................ 23
Outer profile ............................ 34
Part Modeler installation....................8
Parts - saving.................................23
Pockets - profiling............................35
Pockets - roughing............................35
Profiling operation - creating..............34
Registering Edgecam..........................11
Rest roughing..................................30
Roughing operation - creating..............28
Saving parts...................................23
Security Key - fitting..........................9
Sequence ........................................2
Setup - running..................................8
Simulating - speed control..................37
Simulating machining..........................36
Solid model - loading..........................16
Specifying code generator....................26
Specifying material............................25
Starting Edgecam...............................11
Stock creating...................................18
showing translucent...........................19
Student Edition mode - switching to ....10
Switching views ................................17
Template - opening............................40
Template, Code Wizard........................40
Tool diameter - specifying.....................29
Tool graphic - hiding...........................33
ToolStore
Selecting tools in..............................29
Specifying database...........................25
Translucent stock..............................19
Undo..............................................19
Undo command ..................................19
Upper boss - roughing.........................28
User interface
customising ....................................13
overview .......................................12
V
Viewing Features..............................22
Z
Zooming .......................................17